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Introduction 

Every conceivable measure has been taken to ensure the accuracy and 
completeness of this documentation. However, as errors can never be fully 
excluded, we always appreciate any information or suggestions for improving the 
documentation. E-mail: documentation@wago.com 

 

Service and Technical Support 

Additional information regarding this and other products (e.g., data sheets) is 
available on our website www.wago.com.  

If you can not eliminate errors or faults using the measures described in this 
manual we will be glad to assist you further. Contact us at: 

AUTOMATION Support 
Phone:  +49 571 887 555 
Fax:  +49 571 887 8555 
E-mail:  support@wago.com 

 

Additional Support 

The Seminar and Training department offers useful seminars to support you in the 
use of WAGO products. For more information, visit our website or call +49 571 
887-327, or send an e-mail to training@wago.com. 

 

Trademarks 

We wish to point out that the software and hardware terms as well as the 
trademarks of companies used and/or mentioned in the present manual are 
generally protected by trademark or patent. 

 

 

 

 

 

 

 

Copyright © 2010 by WAGO Kontakttechnik GmbH & Co. KG. All rights reserved. 
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1 Safety 

1.1 Notes on This Quick-Start Guide 

The fieldbus coupler shall only be installed and operated in conjunction with these 
quick-start instructions and the system description. Detailed information on the 
coupler is provided in the 767-1101 manual. 

 

 
WARNING  

Observe release notes! 
Please note that, within the SPEEDWAY system, a function is provided without 
restriction only if all system's components have the same system-wide firmware 
release.Therefore, always observe the appropriate release notes on products used. 

 

 
 NOTICE  

Supply layout! 
In addition to these operating instructions, you will need the "WAGO 
SPEEDWAY 767, System Description and Information" manual, which can be 
downloaded at www.wago.com. There you will find information regarding supply 
layout, etc. 

 

http://www.wago.com/�
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1.2 Explanation of Symbols 

 
 DANGER  

Warning of physical injury 
Indicates a direct hazard with a high level of risk which leads to death or serious 
physical injury if not avoided. 

 

 

DANGER  
Warning of physical injury from electric current 
Indicates a direct hazard with a high level of risk which leads to death or serious 
physical injury if not avoided. 

 
 WARNING  

Warning of physical injury 
Indicates a possible hazard with a moderate level of risk, which may lead to death 
or (serious) physical injury if not avoided. 

 
 CAUTION  

Warning of physical injury 
Indicates possible hazards with a low level of risk, which could lead to minor or 
moderate physical injuries if not avoided. 

 
 NOTICE  

Warning of damage to equipment 
Indicates a possible hazard that could lead to equipment damage if not avoided. 

 

 

NOTICE  
Warning of damage to equipment from electrostatic discharge 
Indicates a possible hazard that could lead to equipment damage if not avoided. 
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Note  
Please note 
Indicates possible malfunction, which does not lead to equipment damage if it is 
not avoided. 

 

 

Information  
Reference to additional information 
Indicates other sources of information which are not an integral part of this 
documentation, such as the Internet. 
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1.3 Validity of This Quick-Start Guide 

These operating instructions are only applicable to the positive-switching WAGO 
SPEEDWAY 767 Series fieldbus coupler, item number 767-1101. 

 

1.4 Use in Compliance with Underlying Provisions 

The PROFIBUS DP/V1 fieldbus coupler for PROFIBUS DP provides digital 
process data from digital and analog I/O modules. The data is gathered by the DP 
master and made available to a control system for further processing. 

The fieldbus coupler shall not be used to control safety-related functions; i.e., 
emergency-off devices shall not be operated with this fieldbus coupler. 

The fieldbus coupler shall only be used as a unit or in combination with I/O 
modules from the WAGO SPEEDWAY 767 Series. 

The fieldbus coupler was developed for applications requiring IP 67  
(NEMA type 6, 6P) protection. 

The fieldbus coupler is expandable by a maximum of 63 I/O modules from the 
WAGO SPEEDWAY 767 Series. 

Applications other than those described in this manual are not permitted.  

 

1.5 Personnel Qualification 

All sequences implemented on the fieldbus coupler may only be carried out by 
electrical specialists with sufficient knowledge in automation. The specialists 
must be familiar with the current standards and guidelines for the fieldbus coupler 
and automation environment. 
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1.6 Basic Safety Information 

This section contains a summary of the most important warnings, which are also 
repeated in the individual sections. They serve as a protection to your health and a 
protection from equipment damage on the 767 Series components (fieldbus 
coupler and the I/O modules connected to it). Read and adhere to the following 
safety precautions before using the fieldbus coupler. 

 

 

DANGER  
Electric voltage! 
Operate the 767 Series components exclusively with 24VDC PELV (Protective 
Extra Low Voltage) or SELV (Safety Extra Low Voltage) voltage sources. Failure 
to comply may result in electric shock. 

 
 CAUTION  

Hot connection sockets! 
Even when taking into account derating, high surface temperatures on the metallic 
connection sockets and on the enclosure can arise during operation. If the 767 
Series component has been in operation, allow it to cool off before moving it. 

 
 NOTICE  

The highest current carrying capacity of the supply contacts is 4A! 
Always observe the maximum current carrying capacity per supply line (ULS, UA) 
for each 767 Series component and the overall power consumption for all 767 
Series component. Neither of these values shall exceed 4A since an increase in 
current causes the contacts to overheat and damages the 767 Series components. 
Information regarding the power demand of each 767 Series component can be 
found in the corresponding data sheet, which is available from www.wago.com. 

 
 NOTICE  

Exposed connections! 
If connections have not been closed with protective covers, liquid or dirt can 
penetrate the fieldbus coupler and ruin it. Close all unneeded connections with 
protective caps to ensure that IP 67 degree of protection is provided. 

• Disconnect the power supply from the system on which you wish to mount 
the 767 Series component.  

• Always keep the cover cap of the DIP switch closed. 

• Observe the appropriate accident prevention regulations for your system 
during assembly, startup, maintenance and repairs. 

• The operating instructions of the 767 Series components and the system 
description must be readily available at the workplace. 

http://www.wago.com/�
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• Observe the exact positioning (coding) between plug and socket. 

• The 767 Series component shall not come in contact with substances having 
seeping and insulating properties. Otherwise, additional measures shall be 
taken for the devices, such as installation of an enclosure that is resistant to 
the above-mentioned substance properties.   

• Electronic components fulfilling the ESD requirements according to the IEC 
61000-6-2 are integrated in the 767 Series component. Since, under 
unfavorable circumstances, higher voltages may also occur due to electrical 
charge in the field, discharge must be ensured before performing work on 
the 767 system. 

• Observe the correct layout of the potential equalization. 

• Keep all cables a sufficient distance away from electromagnetic sources of 
interference in order to maintain a high level of interference resistance of 
the 767 system against electromagnetic emissions. Use only shielded cables 
at the necessary locations, and always observe the appropriate standards for 
EMC-suitable installations. 

• For the power supply and for the S-BUS, use only pre-assembled WAGO 
system cables, so the specified characteristics of the technical data can be 
achieved. 

• Replace defective or damaged 767 Series component (e.g., deformed 
connections), else function disruptions can occur in the respective fieldbus 
stations or nodes. 

• When laying any cables, make sure that you do not lay them within the 
shear range of movable machine parts. 

• For each activity, observe the corresponding personnel qualification in 
Section 1.5. 

• Observe the marking on the front and rear side of the 767 Series component. 

 

 

1.7 Safety Equipment 

All 767 Series products are designed according to the IP 67 safety class. This 
consists of, among other things, complete touch protection of electric voltages and 
currents – even when wet. 
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1.8 Technical Condition of the 767 Components 

If any change is made to the 767 Series components or software and firmware 
without the written approval of WAGO Kontakttechnik GmbH & Co. KG, all 
liability claims are nullified.  

 

1.9 Notes on Operation 

When integrating the 767 Series components in your machine or system, all the 
currently applicable norms, regulations and guidelines shall be observed during all 
activities. The emergency stop equipment shall remain effective in all operating 
modes of the system and machine. 

For protection from electromagnetic interferences 

• Connect your system to protective earth (PE), and  

• Ensure that the cable routing and the installation of the fieldbus cable, S-
BUS cable, supply cable, and sensor cable are correct. 

 

The following elements for 24V supply shall be present: 

• Outer lightning protection on buildings 

• Inner lightning protection of supply lines and signal lines 

• Safe electrical separation of low voltage 24VDC through PELV (Protective 
Extra Low Voltage) or SELV (Safety Extra Low Voltage) voltage sources 
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2 Description 

This quick-start guide describes the most important steps for starting  

• the fieldbus coupler, 

• the fieldbus coupler on an IPC 758-870,  

• the fieldbus coupler on a S7-300. 

Chapter 3 deals with wiring the fieldbus coupler and setting the PROFIBUS 
station address. Kapitel 4 provides an application example on how the fieldbus 
coupler is operated on a WAGO industrial PC with PROFIBUS Master interface 
(IPC, 758-870/000-001). Furthermore, the creation of a CoDeSys 2.3 project is 
described in detail. Chapter 5 describes how the fieldbus coupler is operated on an 
S7-300. Chapter 7 offers a brief introduction to WAGOframe FDT/DTM 
configuration software. Information on the system update can be found in  
Section 7. 

2.1 Accessories 

This manual was created using the following software and hardware: 

Name Description Version 

WAGOframe   
CD-ROM Ver. 3.0.0 

FDT/DTM frame application 759-370 
Ver. 1.0.8 

WAGO USB driver USB driver for 767 Series  759-922 
Ver. 1.3.2 

WAGO service interface DTM DTM for communication  759-371 
Ver. 2.1.0 

WAGO DTM for fieldbus 
coupler and I/O modules 

Device DTM for 767 series 
(programmable) fieldbus coupler  
and I/O modules  

759-361 
Ver. 2.1.0  

System update DTM DTM for firmware update  759-362 
Ver. 1.0.0 

SIMATIC Manager 5.3 S7 development environment - 

CoDeSys 2.3.9.3 IEC development environment for 
WAGO IPC 758-870 

759-333 

GSD WAGO GSD files - 

767-110, 
firmware 

WAGO firmware files - 

Fieldbus coupler for PROFIBUS FC, 8 DI, 24 V 767-1101 

WAGO IPC 
(PROFIBUS Master) 

Industrial PC with PROFIBUS 
connection 

758-870/000-001 
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Name Description Version 

S7-315 2DP 
(PROFIBUS Master) 

Siemens PLC with Profibus 
interface 

6ES7315-2 
AF00-0AB0 

Digital input module 8 DI, 24 V DC  
(8xM8) 

767-3801 

Digital output module 8 DO, 24 V DC 0.5 A  
(8 x M8) 

767-4801 

USB communication cable 
(WAGOframe, CoDeSys 3) 

M8 plug, straight 756-4101/0042-0030 

PROFIBUS cable (B coded), 
with one end of the cable fitted 

M12 right angle socket,  
2 m 

756-1102/0060-0200 

Profibus link  
(B coded) 

M12 plug, straight 756-9405/0060-0000 

System bus cable  
(B coded), 
with both ends of cable fitted 

M12 socket, right angle, 
M12 plug, right angle,  
0.2 m 

756-1306/0060-0002 

System bus terminating plug  
(B coded) 

M12 plug, straight 756-9409/0060-0000 

Power supply cable  
(A coded), 
both ends of cable fitted 

M12 socket, right angle, 
M12 plug, right angle, 
0.2 m 

756-3106/0040-0002 

 
When placing an order, also take into account an additional power supply cable 
between the power supply unit and the fieldbus coupler, in addition to the number 
of I/O modules needed. 
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3 Connection 

 
 NOTICE  

Exposed connections! 
If connections have not been closed with protective covers, liquid or dirt can 
penetrate the fieldbus coupler and ruin it. Close all unneeded connections with 
protective caps to ensure that IP 67 degree of protection is provided. 

Then tighten the connector by hand when power is switched off. Using 
mechanical means to tighten it may strip the threads. In such a case, the fieldbus 
coupler is to be replaced. 

Tightening torques for the connectors: 0.6 Nm 
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Wire the 767 components as shown in the following figure: 

 
 
 

 
 

 
 
 
 
 

Supply voltage (M12 connectors, A coded, 4 poles): 
Power supply feed-in for logic circuits and outputs is provided via separate 
contacts. 

 

PROFIBUS S-BUS 

Power 
supply 

S-BUS 
termination

Infeed of 24V 
power supply 

USB: 
WAGOframe 

PROFIBUS 
link 

Connection Contact Description 

 IN  OUT 1 24VDC ULS   

2 24VDC UA 

3 0V ULS 
4

1

2

3

 

1

4

3

2

 4 0V UA  
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PROFIBUS: 
You need a PROFIBUS cable with a B coded M12 socket to connect to the 
PROFIBUS. 

Connection Contact Description 

IN  OUT 1 +5V 

2 Cable:  A 

3 0VDC 

4 Cable:  B 

5 Not assigned 

3

2

1

4

 

3

4

1

2  

Connecting thread Shielded 

 

S-BUS: 
The system bus is used for internal communication between the fieldbus coupler 
and the 767 Series I/O modules connected to it. 

Connection Contact Description 

 OUT 1 TD + 

2 TD - 

3  RD - 

4 RD + 

5 0VDC 

3

4

1

2

5

 

Connecting thread Shielded 
 

Service port (USB): 
The fieldbus coupler provides the following service at the service port: 

• I/O-Service 
The function "I/O-Service" is used by the FDT/DTM frame application 
"WAGOframe" to assign parameters to and configure the fieldbus coupler. 

 

 

 

 

 

The USB Speedway device driver is part of the installation programs of the 
"WAGOframe" application. For more information, see Chapter 6.1. 
V

Connection Contact Description 

IN 1 + 5V 

2 - Data 

3  + Data 

4 0VDC 1

244

3
 

Connecting thread Shielded 
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Digital inputs: 
The sensor cables provide power to the connected sensors and transfer the sensor 
signals. The table below outlines the connection assignments for the sensor 
connections: 

Connection Contact Description 

IN IN 1 24VDC (supplied from ULS) 

3 0VDC 

1

43

 
X1, X3, X5, X7 

14

3
 

X2, X4, X6, X8

4 Input 

 

 
 NOTICE  

The highest current carrying capacity of the supply contacts is 4A! 
Ensure that the sensors from the ULS supply line are supplied with power. The 
sensor's power consumption is to be taken into consideration when determining 
the present power demand for the ULS supply line. 

 
 NOTICE  

The total maximum power consumption of the sensors must not exceed 
400mA (50mA/channel). 
Please note that the combined power consumption of all connected sensors is not 
to exceed 400mA. The distribution of power among the existing connections is 
depending on the individual power requirements of the sensors. 
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3.1 Assigning the PROFIBUS Station Address 

Use the DIP switch block (switches 1 ... 7) to set the station address. 

 

Switches 1 2 3 4 5 6 7 8 9 10 11 12 

Binary values for 
setting addresses/ 
functions 

20 

(1) 
21 

(2) 
22 

(4) 
23 

(8) 
24 

(16) 
25 

(32) 
26 

(64) 
SSA - - Boot/ 

Execute 
Reset 

Switch setting Off Off Off Off Off Off Off Off Off Off Off Off 

 

Use switches 1 to 7 to set the PROFIBUS station address of the fieldbus coupler. 
Station addresses in the range from 0 to 125 are permitted. Setting addresses 126 
and 127 leads to the fieldbus coupler taking the PROFIBUS address 126 and 
allows the station address to be assigned via PROFIBUS. 

Switch 8 activates the operating mode Set_Slave_Address (SSA), in which a 
station address is assigned via PROFIBUS independent of the switch positions 1 
to 7. In this case, the fieldbus coupler can be reached at address 126. 

For example, to set the PROFIBUS station address 100, proceed as follows: 

1.  Open the cover by unscrewing the M4 screw with a screwdriver.  

2. For Host ID 100 set switches 3, 6, 7 to "On". 
(22+25+26 = 4+32+64 = 100).  

3.  Close the cover and screw it securely in place to maintain degree of 
protection IP 67. 
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4 CoDeSys 2.3 Example 

In this example, the fieldbus coupler shall be operated on a 758-870/000-001 (IPC 
as PROFIBUS master). 

1. Copy the "*.GSD" and "*.DIB" files to any directory on your PC (e.g. 
"C:\Temp"). 

2. Create a blank project via Menu File -> New. 

 

3. Select the WAGO IPC with PROFIBUS master functionality "758-870/000-
001_EC1DPM" as the target system. 

4.  Select the programming language and create a PLC program. 
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1.  Click the "Resources" tab and open the "PLC Configuration". 

2. In Extras menu, select Add configuration file to import the GSD files for 
the fieldbus coupler and the Speedway I/O modules.  

 

3. Switch to the directory containing the GSD files (e.g., "C:\Temp"). 

4. Change the file filter to the file ending "PROFIBUS (*.gs?)" in the "Select 
configuration file“ dialog.  

5. Select "B767_G21.gsd" as the DPV0-GSD file for the fieldbus coupler and 
click [Open] in the "Select configuration file“ dialog. 

 

6.  Click [OK] to copy the GSD file into the WAGO software directory. 

7.  Repeat the previous steps for the "B767_E21.GSD" file. 
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In the next step, add the PROFIBUS participants in the PLC configuration. 
 

 

1. Select the element "PLC Configuration" in the middle window and open the 
context menu. Click on Append Subelement > EC1-DEB-DPM... in the 
context menu. 

 The hardware wizard adds a Profibus master with station address 1. 
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2. Select the new element "EC1-DEB-DPM(VAR)" in the middle window and 
open the context menu. Open the context menu and select Append 
Subelement > WAGO 767-1101 (FW:02…)V0... 

 

The hardware wizard adds the fieldbus coupler as a Profibus slave with station 
address 2 for the control configuration. 

3. Select the new entry "WAGO 767-1101" in the middle window and switch 
to the "DP Parameters" tab. 

 

4. The station address on the "DP Parameters" tab must match the fieldbus 
coupler station address set via DIP switches. 
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In the next step, the I/O modules are linked behind the fieldbus coupler in the PLC 
configuration. Switch to the "Inputs/Outputs" tab. 

 

 

In addition to the actual process data, each 767 component also provides 
diagnostic and parameter information.  
In the selection, you find different 767 component options on how the additional 
information can be made accessible to the PROFIBUS master. Version naming is 
a combination of the item number of the 767 component and a "version code". 

Version Code Description 
(without extension) Only the process data are exchanged with the master. 

DIAG Diagnostic information is sent to the master via acyclic services. 

DIAG, PRM Diagnostic information is sent to the master via acyclic services.  
Adjustable parameters of the 767 component are displayed in the 
parameter message. 

PI-DIAG Diagnostics information is displayed in the data exchange area. 

PI-DIAG, DIAG Diagnostic information is displayed in the data exchange area and 
also sent to the master via acyclic services. 

PI-DIAG, DIAG, PRM Diagnostic information is displayed in the data exchange area and 
also sent to the master via acyclic services.  
Adjustable parameters of the 767 component are displayed in the 
parameter message. 

 
In the case of large node configurations, it may be necessary to do without 
transferring module parameters of individual 767 components due to the 
restriction of the parameter message to 244 bytes. 
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The PLC Configuration is shown below: 

 

1. Expend the tree structure of the middle window and create three new 
variables of the type "BYTE" for the three 8DO modules by activating the 
cursor in front of "AT %Q.." and assigning any variable name (e.g., "bOut" 
for the third output module). 
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2. Click the "POU" tab and double-click "PLC_PRG" to open the PLC editor. 

 

3. Add more networks in order to assign values to the just created variables. 

4. Press [F11] to compile the CoDeSys project or select Project > Build. 

5. Check the communication parameters in the menu 
Online > Communication Parameters… 

 

6. Press [Alt] + [F11] to transfer the application to the 758-870 or select 
Online > Login. 

7.  Press [F5] to start the application on the 758-870 or select Online > Run. 
The current process data is displayed in the program code. 

8. Select Online > Create boot project to permanently save the program in 
the PLC. 
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5 S7-300 Example 

In this example, the fieldbus coupler shall be operated on an S7-315 2DP (as 
PROFIBUS master). 

1. Copy the "GSD" and "*.DIB" files to any directory on your PC (e.g., 
"C:\Temp"). 

2.  Launch the "SIMATIC Manager" and use the wizard to create the basic 
project. 

 

3. Click the [Next >] button. 

 

4. Select the CPU you are using and check the MPI address.  
Then click [Next >]. 
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5. Assign the programming language with which to create your PLC program. 
In this example, "FDB" is used. Then click [Next >]. 

 

6. Assign a project name and press the [Finish]. 
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7. Double-click "SIMATIC 300 Station" in the left window. 

8. Double-click "Hardware" in the detailed window to open the hardware 
configurator "HW Config".  
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9. Install the GSD files via Options > Install GSD File… 

 

10. In the next dialog box, click [Browse ...] in the the directory containing the 
GSD files (e.g., "C:\Temp"). 

 

11. Click the [Select all] button to select the device descriptions for the 767 
components and click [Install] to transfer them to the device catalog. 

 

12. Click [YES] to acknowledge the prompt. 

13. Click [OK] in the following dialog to acknowledge the prompt. 

14. Click [Close] to finish updating the device catalog. 
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In the next step, add a "DP master system". 

1. Select the "DP" line below CPU315-2DP in the hardware configurator and 
right-click to open the context menu. Select Add Master System in the 
context menu. 

 

 

In the next dialog box, specify the station address of the DP master and create a 
new subnet. 

 

2. Set the station address of the DP master interface and click [New ..]. 
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3. Click [OK] to accept the settings. 

 

4. Select the "DP master system" (a solid line is displayed"). Open the device 
catalog to assign the WAGO 767-1101 to the "DP master system". You find 
the 767-1101 under: PROFIBUS-DP > Additional Field Devicees > I/O > 
WAGO SPEEDWAY 767. 

5. Double-click in the catalog and add the 767-1101 by drag-and-drop to the 
DP master system. 
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The following dialog box appears. 

 

6. Change the address to the station address of the fieldbus coupler set by DIP 
switches. Confirm your entry by clicking [OK]. 

 

7. Expand the device catalog and add the remaining I/O modules to the 767-
1101 by drag-and-drop. 
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In the selection, you find different 767 component options on how the additional 
information can be made accessible to the PROFIBUS master. Version naming is 
a combination of the item number of the 767 component and a "version code". 

Version Code Description 
(without extension) Only the process data are exchanged with the master. 

DIAG Diagnostic information is sent to the master via acyclic services. 

DIAG, PRM Diagnostic information is sent to the master via acyclic services.  
Adjustable parameters of the 767 components are displayed in the 
parameter message. 

PI-DIAG Diagnostics information is displayed in the data exchange area. 

PI-DIAG, DIAG Diagnostic information is displayed in the data exchange area and 
also sent to the master via acyclic services. 

PI-DIAG, DIAG, PRM Diagnostic information is displayed in the data exchange area and 
also sent to the master via acyclic services.  
Adjustable parameters of the 767 components are displayed in the 
parameter message. 

 
The following graphic shows the fully configured network.  

 

8. Select Station > Save and Compile to save the network configuration. 
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9. Return to the "SIMATIC Manager". 

 

10. In "OB1" double-click the "LD/IL/FDB" editor to add an application to the 
project. 

In this example, only one counter output on the outputs. 

 

11. Add a network of your choice and save the changes. Click [Ctrl] + L to 
transfer the new project to the PLC. 
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6 WAGOframe 

WAGOframe is an FDT/DTM frame application for configuration, diagnosis and 
updating of FDT-compliant field devices. 

FDT/DTM is a manufacturer-independent concept for setting of parameters for 
field devices from different manufacturers using only a single program.The phrase 
"Field Device Tool"(FDT) not only represents a concrete program, but also 
defines the interfaces that a program must deal with in order to cooperate with 
DTMs from different manufacturers.  

A "Device Type Manager"(DTM) groups all the setting options for a field device 
(including graphic interfaces) into a single program that is executed in an 
FDT/DTM frame application. The specification makes a distinction between 
device DTMs, communication DTMs and gateway DTMs. 
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6.1 Installation 

A browser-based wizard leads you through the installation of the required drivers, 
DTMs and programs. When performing an installation from the CD, the Internet 
browser used will open automatically to the following page: 

 

1. When performing an installation from the file system switch to the directory 
"~/WAGOframe CD-ROM_v3.0.0" and open the file "Deutsch_main.htm". 

 

2. To install all the required components, select "Series 767 + WAGOframe". 
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3. The following page will be displayed. Execute all five installation programs 
one after the other to install the configuration software. 

 

 

 

 

Note  
Installation of the USB driver 759-922 is not required if this driver has already 
been installed via "CoDeSys 3" setup. Any USB driver that is already installed 
will then be updated. 

If an older version of "WAGOframe" is installed, this must first be de-installed 
with the installation routine. The same applies to DTMs. 
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The installation sequence for the individual components is always the same, 
beginning with language selection. 

 

1. Continue by clicking [OK]. 

 

2. Continue by clicking [Next >]. 

 

3. Read the Terms of Use for the WAGO USB driver before selecting "I 
accept...". Confirm this selection. Then click on [Next]. 
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4. Check your personal settings. 

 

5. Continue by clicking [Next >]. 

 

6. Select the installation path under which the application is to be saved. 

7. Start the installation by clicking the [Install] button. 

 

8. Continue by clicking [Next >]. 
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9. Complete the installation by clicking [Finish]. 

 

10. Quit the wizard by clicking the  
[Finish] button. 

Repeat these steps for the other four software components: 
• WAGOframe: Item No. 759-370 (Version 3.0.0) 
• WAGO service interface DTM: Item No. 759-371 (Version 2.1.0) 
• DTM for the fieldbus coupler and I/O modules: Item No. 759-361  
     (Version 2.1.0) 
• DTM for the system update: Item No. 759-362 (Version 1.0.0) 
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6.2 Starting Up the Fieldbus Coupler 

Now switch on the power for the fieldbus coupler and link its service port to a free 
USB slot on your PC using the USB communication cable 756-4101/0042-0030. 

Communication between WAGOframe and the fieldbus coupler is carried out via 
the communication DTM "WAGO Service Interface". The COM port that is used 
depends on the USB slot and must be parameterized accordingly in the WAGO 
Service Interface. 

 

 

Note  
If the fieldbus coupler is linked to a different USB slot at a later time, this will 
also result in a change to the COM ports used by "I/O-Service". In this case the 
setting for the serial interface must be adapted accordingly in the communication 
DTM. 
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6.3 Operation 

Start the WAGOframe program using the icon on the desktop, or via Start > 
Programs > WAGO Software > WAGOframe > WAGOframe. 

 

After starting you can select either the "Point to point mode" or the "Expert 
mode". The "Point to point mode" was developed specially for the configuration 
of simple devices (such as WAGO Jumpflex). Use the "Expert mode" to set 
parameters for the 767 components.  

 

1. Switch to the "Expert mode" and click  
[Next >]. 

 

No device catalog will have been created on the initial call-up. 

2. Click [Yes] in the dialog window that then appears to configure a device 
catalog on your PC. 
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3. In the window "Network view" mark the element "Network" and select the 
function Add... using the context menu (right mouse key). A dialog window 
then opens showing all available communication drivers. 

 

 

 

4. Select the "WAGO Service Speedway" communication driver and confirm 
your selection by clicking [OK]. 

5.  In the window "Network view" double-click on the newly added element 
"<->WAGO Service Speedway". 
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Setting the serial interface parameters for the "WAGO Service Interface" 
communication DTM. 

 

1. Select the interface to be used from the list and accept these settings.  
If there are no entries in the list of available interfaces, check to ensure that 
the fieldbus coupler is switched on and that it is connected to your PC by the 
USB communication cable. 

2. To complete the network configuration you can now select individual 
DTMs from the catalog, or conduct a network scan. 

When adding elements manually please note that each FDT frame application 
differentiates between online and offline modes. Each of these modes has a 
separate scope of functions. 

In the online mode, there is a direct link between the display and the connected 
767 components.  
The offline mode enables the parameterization of a device that is not yet present. 
It will continue to be used to reduce data transfer between WAGOframe and the 
device. If a device is in the online mode, its name is displayed in bold and cursive 
font in the network window.  
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3. To conduct a network scan, open the context menu (right mouse key) of the 
element "WAGO Service Speedway" in the "Network" window and then 
select the entry Create network under the menu item Scan. 

 

4. After performing a network scan, WAGOframe should have found the 
fieldbus coupler and the connected modules . 

5. A "Live List" is created if no matching DTM is found for the fieldbus 
coupler when scanning the network. Click on [Add all and continue] in the 
list. 

 

6. Note that the fieldbus coupler is in the online mode, while the module is in 
the offline mode. Mark module and select the entry  
[Go online] from the context menu to switch to the online mode. 
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7. Open the detail view by double-clicking the fieldbus coupler. WAGOframe 
should appear as follows after editing the window width and closing the 
device catalog: 

 

The current operating mode is shown in brackets behind the first node of the tree 
structure (left window). Please note that changing between operating modes is 
only possible when the detail window concerned is closed. 

Explanations of the buttons: 

• Read:  
 Reads and displays the paremeters found in the fieldbus coupler. 
 
• Write:  
 Writes the modified values to the fieldbus coupler. 

• Close:  
Closes the parameterization user interface (DTM). 

• Help: 
Opens the online help for an entry selected previously (e.g., digital input, blink 
code). 
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7 System Update 

Firmware update for the 767 Series components is performed via system update. 
To ensure that the fieldbus node remains consistent and executable after updating 
the firmware, system update must be performed for both fieldbus coupler and 
connected I/O modules. 

 
 NOTICE  

System update  
Before updating, observe the following measures to prevent any possible damage 
to the 767 system: 
- The power supply must not be disconnected while updating! 
- To exclude any interferences by the fieldbus, the fieldbus cable must be 
  disconnected before updating! 

 

Requirement: 
• You have installed the DTM (759-370) WAGOframe 
• You have installed the DTM (759-371) WAGO service interface 
• You have installed the DTM (759-922) USB driver 
• You have installed the DTM (759-362) system update.   
• Update packages are available for the connected 767 Series components. 
 
 
System Update Procedure 

To perform a system update for each 767 Series component, please complete the 
following steps: 

1. Read 767 components' parameters and save them on your PC. 

2. Update 767 Series components' firmware. 

3. Rewrite parameters from your PC to the 767 Series components. 

4. Set parameters to valid and finish the procedure. 
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7.1 Adding the DTM System Update  

To add the DTM system update to WAGOframe, please proceed as follows: 

1. In "Network View", right-click on the "WAGO Service Speedway" device 
driver. 

2. In the Add... context menu, select "Add". The "Add" dialog box opens. 

 

Figure 1: Adding the DTM system update 

3. In the "Add" dialog box, select the DTM 0767 System Update. 

4. Click [OK] to confirm your selection. 
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7.2 Go online to 767 Nodes using Update DTM 

The firmware can only be updated when a communication connection exists 
between Update DTM and 767 node. Please proceed as follows: 

1. In the "Network View", right-click on the "<Speedway:> 0767 System 
Update" device driver.  

2. In the context menu, select Go online. When the progress bar displays 
100% and the entry is displayed in bold italics, the communication 
connection is established.  
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7.3 Updating the 767 Components 

The current firmware is available from WAGO Support. Send an e-mail with the 
subject "Current Speedway Firmware" and the item number of the respective 767 
components to: support@wago.com. 

Import firmware packages 

To use the received firmware packages, import them into the DTM system update. 
Please proceed as follows: 

1. Save the received firmware packages with the "*.wup" extension to any 
directory on your PC. 

2. Open the DTM user interface by double clicking "0767 System Update" in 
the network view. 

 

3. Click "Package Management" in the left window of WAGOframe.   

4. To import the received firmware files, click [Import].  In the window that 
opens, go to the directory where you have saved the firmware files and 
select the file to be used. Click [Open] to apply the files. 

mailto:support@wago.com�
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Delete firmware packages 

To maintain a clear "Package Management" interface, you can remove unneeded 
update packages from the view. Please proceed as follows: 

1. Select the required firmware files in the right window.  

2. Click [Delete] to remove the selected firmware packages.  
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System update 

 

 

Note  
When updating the firmware of the fieldbus coupler, the saved module parameters 
may be overwritten. Therefore, check your existing configuration after updating 
the firmware. 

Perform the system update here. The module settings you made normally remain 
unchanged. Otherwise, a corresponding warning message appears. If you still 
want to update the firmware, the 767 components are returned to their default 
state. 

1. Click "System Update" in the left window. 

 

2. The fieldbus coupler with all connected I/O modules are listed in the right 
window. All 767 components that can be updated are pre-selected. If the 
pre-selection is incorrect or if specific 767 components should not be 
updated, deselect them. 
"Actual: Version":  Firmware currently present on the device 
"Target: Version":  Version of the firmware that should be loaded into the 
767 components. If multiple "Target" versions can be selected, select the 
one relevant to you.  
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3. Click [Start!] to update the system. The 767 components are marked in 
yellow while being updated. 

 

 

Note  
During the firmware updating process, the fieldbus coupler disconnects each of its 
COM ports. A PC equipped with Windows 2000 will detect this, and a Windows 
message appears. This is not an error message. Confirm the message by pressing 
[OK]. 

 

 

 
Button Description 

[Update List] Use this function to read the node design and the view 
updates. 

[Discard Settings] Discard the selections and settings performed by you. 

[Check Versions] If you made your selection, click this button to perform a 
plausibility check. This checks whether the configuration you 
selected is possible (also automatically performed when 
starting the system update). 

Display downgrade versions If this checkbox is selected, the versions to downgrade a 
device are also displayed in the list of target versions. 

[Start!]/[Abort] Start/abort system udpate. 
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4. If the system update is finished, the updated 767 components are displayed 
in green (see figure).   

 

During system update, all relevant information is stored on your PC. Update can 
be repeated subsequently if the system update fails (components are displayed in 
red). In this case, original parameters remain unchanged.  

If the update for a device fails, please contact WAGO Support. 

 

 

Information  
Further information is given in the WAGOframe manual. 
 

 

 

 



 

 

 

 

  

WAGO Kontakttechnik GmbH & Co. KG 
Postfach 2880    D-32385 Minden 
Hansastraße 27  D-32423 Minden 
Telefon: 05 71/8 87 – 0 
Telefax: 05 71/8 87 – 1 69 
E-Mail: info@wago.com 
 
Internet: http://www.wago.com 
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